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Please Note 
Within Worksheet, go to Help > Check for Software Updates… to find Software Updates, if available. 

REMEMBER: Files modified in newer versions of the software are not necessarily backward compatible with earlier versions of the 

software.  When there is a compatibility issue the following will be seen: Worksheet and Giza will display a message about 

incompatibility; Cap Designer will cause an error in AutoCAD.  

Commercial Software 2016.3 Feature Additions 

1.1 2020 Worksheet 

1.1.1 STANDARDIZING REPORTING  

1.1.1.1 RECONCILING FIELD NAMES AND FIELD AVAILABILITY WITHIN SECTIONS 

Fields in Report Designer have been standardized so that field names are more consistent between Worksheet and Report Designer.  

Fields are also now more consistent from one section to another.  This means that if a field is available in a specific header, the field 

show now also be available in the corresponding footer as well, with few exceptions. 
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1.1.1.2 REPORT TEMPLATE USE OF A LOGO AS SET IN WORKSHEET PROPERTIES 

Worksheet allows for setting a logo within Preferences.  The logo, as an image set in Preferences, is now available within Reporting.  The 

ability to place an image in a template has been kept, so any report template that had an image in it to represent a logo will still work 

and appear as before.  The availability of an actual “Logo” field for use in Reporting allows for a change in Worksheet Preferences to 

propagate across all instance of the field within a Report template with no extra effort. 
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Changing the image for the logo in Worksheet Preferences will automatically change the logo in any Report that has the “Logo” field in 

it. 

 

Please Note: If a different image file is set for use as the system logo, and it is a different size and shape, the results in a Report 

Template may require removing and replacing the Logo field.  This is necessary because the size & shape of the field is set when the 

field is first placed in the template.  Changes made to the logo will be shown, but the image may be distorted as it is forced to fit the size 

and shape of the existing field. 
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1.1.1.3 ADDING ITEM MANAGEMENT FIELDS TO THE PRODUCT DETAIL AND PAGE HEADER SECTIONS 

The Item Management columns that were added to Worksheet are now available for use within Report Designer.  The fields are 

checkboxes, confirming that a line item is a Special, is Complete, is Locked, Flagged, and/or Annotated. 

Design view: 

 

 

Report View: 
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The Item management fields are also available to use in the Page Header section, to label fields that are shown directly down the 

report, for reports that are more column-based.  Since Annotations are usually a wide text field, they wouldn’t usually be used in 

column-based reports; for this reason, “Annotation” is not shown in this example. 

Design view: 

 

 

Report View: 
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1.1.2 ENHANCING REPORT VIEW  

1.1.1.4 CHANGING REPORT VIEW TO SHOW NON-DEFAULT WORKSHEET 

Report View now has the ability to show any currently-open worksheet or existing worksheet file in addition to the pre-set worksheet 

you are used to seeing.  This allows a Report preview using the actual worksheet information of the in-use worksheet.  This feature will 

allow for faster reviews of changes made to the report template, making the use of Report Designer more efficient overall. 

The same report template can be quickly applied to any worksheet to verify information displays as expected.  

  

 

Template applied to “Visual Impression Sample”: 
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Template applied to “SP4 for Item Management”: 
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1.1.1.5 LIMITING THE NUMBER OF ITEMS SHOWN IN REPORT VIEW 

The user can now limit the number of items shown in Report View. Limiting the number of items shown in Report View makes the 

generation of the view more responsive.   

Use Report Preferences to set the number of items you want to see in the preview.  By default, “All Items” is checked.  This preserves 

the existing behavior of Report View. 

 

 

Unchecking the “Display all Items” box enables the control to set the number of items to display, with 1-10 being the choices. 
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Here is a Report view of a large worksheet file: 

 

Here is a Report view with the number of items set to display at “4”, of the same large worksheet file: 
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Changes included in previous releases 

Commercial Software 2016.2 Feature Additions 

1.2 All applications 

1.2.1 HELP FILES ARE NOW WEB-BASED 

Help files for all Office applications are now served through the web to the embedded Help browser within each application.  When an 

internet connection is not available, locally installed Help files are accessed.  This change should be transparent in terms of functionality.  

Serving the Help files from the web allows for more frequent updates and changes to the Help files. 

1.3 2020 Worksheet 

1.3.1 COLOR FIELDS WITHIN REPORTING  

The “Color” filed has been added to Reporting.  The color field will be available for use in the Product Detail and Group Header areas of 

Report templates.  The field is resizable, and may have borders applied.  

 

 

               

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Color in the Group Header Color in the Product Detail 
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Please note: Sorting by the color field so that it matches the sort method of Worksheet is not supported within the Reporting engine; 

there is a limitation in the technology used to create Reports.  If you wish to preserve the sort order (by Color) from the Worksheet 

view, sort within Worksheet then apply the Report template.  If no sort method was saved in the template, the sort order will persist 

from the Worksheet view.  
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Commercial Software 2016 Feature Additions 

1.1 All applications 

1.1.1 ADD ADDITIONAL, MORE MODERN CASUAL FURNITURE TO DMO CATALOG 

DMO now includes a wider assortment of casual and lounge furniture, allowing more flexibility when furniture for reception, 

lounge, and common areas is needed that is not manufacturer-specific.  These additions are contemporary and more easily blend 

with the latest offerings from furniture manufacturers. 
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1.2 2020 Worksheet 

1.2.1 COLOR-CODE ITEMS IN 2020 WORKSHEET  

Designers want to quickly and easily see groups of items in their worksheet. The fastest way to make items stand out is by 

color. Colors may be used to represent truck loading order, unloading/stage area, installation sequence, item type, area 

“membership” (department, group, etc.), manufacturer, catalog, etc.   

The new Color column is added to the Worksheet and turned on as a default when you first load v2016.   

Colors may be assigned to items in the following ways: 

 By Selection from a new “Colors” Selection on the Item Menu. 

 By criteria 

 By Selection (Select items>Edit>Assign) 

 Within the Item Detail 

• Clicking on the cell in the Color Column 

 

Default values for the Color column may be set in Worksheet preferences. 

Colors will display when you print from 2020 Worksheet and will be included in a Cap Studio SIF Export.  
1.2.2 ABILITY TO SAVE SORT CRITERIA 

Information within worksheets requires different sort orders for varied reasons.  Examples of different sorting methods that are 

used include installation documents, spec-checking, optioning by area, subtotal by area/department/etc.  These multiple uses of a 

worksheet’s information frequently require the sorting and arrangement of items in specific ways, shifting between uses and 

modes frequently.  Saving these sort methods and reusing them later, similar to discounts and discount schedules or Report 

Designs, save time and add efficiency to the design and sales process as it relates to Worksheet.  Worksheet users want to save the 
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sort order of worksheets so that time and effort is reduced; saving and reusing those sort orders that are commonly used while 

working with specifications accomplishes this. 

The ability to save the sort order within Worksheet is now possible.  Accomplished through the “Multiple Sort” dialog, saving a Sort 

Setting (the term for a saved sort order allows it to be loaded later, or even shared with other users.   

  

 

 

 

 

 

 

 

 

 

 

 

 

Sort Settings may also be loaded through a toolbar drop list. 

 

 

 

 

 

 

 

 

Sort Settings are saved to a specific folder on the user’s system, but they can be saved to, and opened from, any folder, as chosen 

by the user.  Only Sort Settings stored in the folder as set within Preferences will appear in the lists shown within the software. 
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1.3 2020 Giza 

1.3.1 AUTOCAD IMPORT ENHANCEMENTS 

It is not uncommon for Giza to have problems when importing a file.  Problematic DWG file(s) come to tech support, which run a 

series of clean-up steps, import it into Giza and send the Giza file back to the user.  Information and feedback given during the 

importing of a file into Giza will provide the user with information to help themselves overcome failures.  When an import of a file 

containing a bad state happens, the current result is usually an error that is likely to have no meaning to the user.  A description of 

the bad state detected and common steps to correct the state will avoid calls to technical support and allow the user to develop the 

knowledge and skills to solve the problem independently.  Any correctable state is during the import. 

The import function for DWGs within 2020 Giza has been enhanced so that common issues with imported files are now resolved 

during the import when possible and notification of the issue(s) given in a new dialog window.  Various checks are run during the 

import, as shown in this dialog box: 

   

 

 

 

 

 

 

 

 

 

 

 

Import Status Definitions 

 None Found (green filled circle) – Nothing detected in the source file relating to the check. 

 Detected (red filled circle) – The check detected an issue that could not be corrected. 

 Resolved (yellow filled circle) – The check detected an issue or issues and was resolved by converting thing(s) that caused 

the issue(s) to a standard Giza equivalent. 

Checks made during the import and what they mean 

 Does the file contain corruption? 

o Yes – The file cannot be imported 

o What this means – This file cannot be imported corruption of some sort was detected. You should contact the 

provider of the file and let them know that it contains some sort of corruption.  Many applications, such as 

AutoCAD, have functions that can attempt repairs to files. 

 Are XREFs detected? 
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o Yes – XREF'd file is not included in the import 

o What this means - The import detected an External Reference (XREF) attached to this file.  The import process 

filtered the XREF; it is not part of the results in Giza.  The XREF may not be necessary to use the file.  You should 

contact the provider of the file and ask them if any XREF(s) attached to the file is required for your use of the file. 

 Are frozen layers detected? 

o Yes – Frozen layers in the source file are set to "Off" in Giza. 

o What this means – The import detected one or more layers are "frozen" in the file being imported.  Layers frozen 

in AutoCAD are not visible and modification is restricted.  These Frozen layers are set to "Off" within the results in 

Giza. 

 Are locked layers detected?  

o Yes – Locked layers are set to "Back" in Giza 

o What this means - The import detected one or more layers are "locked" in the file being imported.  Layers locked 

in AutoCAD are visible but modification is restricted. These Locked layers are set to "Back" within the results in 

Giza. 

 Are unsupported objects found? 

o Yes – Unsupported objects are filtered during the import and not included in the results within Giza. 

o What this means – The import detected one or more objects that are not supported by Giza.  The import process 

filtered these items; they are not part of the results in Giza.  These unsupported objects may not be necessary to 

use the file.  These objects are often "AEC objects", which come from Autodesk's AutoCAD Architecture (also 

known as Architectural Desktop).  You should contact the provider of the file and ask them what might be out of 

the ordinary with the file.  Most objects not supported are proprietary to a specific application; the source CAD 

application can usually simplify the items to basic geometry.  

 Are any items not set "ByLayer"? 

o Yes – Non-ByLayer items have been left as-is. 

o What this means - The import detected one or more Non-ByLayer items.  These items' properties have been 

preserved within the results in Giza.  An example of a non-ByLayer item would be a line that is on layer A, where 

layer A is yellow, but the line's color has been set to blue.  The line in this case is "non-ByLayer".  In this example, 

result in Giza and would be a blue line, NOT yellow.  

 Are there unsupported linetypes? 

o Yes – Lines on Unsupported Linetypes have been converted to the standard Giza linetype. 

o What this means - The import detected one or more lines created using a linetype that is not supported by Giza.  

Items that drawn with these types of line may also be present.  Lines and items made with unsupported linetypes 

have been converted to use the standard Giza linetype within the results in Giza. 

 Are there unsupported linetypes text styles?  

o Yes – Text made using an Unsupported Text Style(s) have been converted use the standard Giza text style. 
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o What this means - The import detected text made using a text style not supported by Giza.  Text made with an 

unsupported text style has been converted to use the standard Giza text style within the results in Giza.   

 Are there unsupported dimension styles? 

o Yes – Dimensions made using an Unsupported Dimension Style(s) have been converted use the standard Giza 

dimension style. 

o What this means – The import detected dimensions made using a dimension style not supported by Giza.  The 

import process filtered these dimensions; they are not part of the results in Giza. 
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1.4 2020 Cap 

1.4.1 SUPPORT FOR AUTOCAD 2017 

2020 Cap now fully supports AutoCAD 2017, the most up-to-date and advanced version of AutoCAD available.  Through the support 

of AutoCAD 2017, 2020 Cap users can take advantage of AutoCAD’s new and useful functions, making their daily work both easier 

and efficient.      

1.4.2 BUILDING, FLOOR, DEPARTMENT, PERSON VALUES 

Building, Floor, Department, Person criteria are now available within a drawing to allow values to be set in a natural way, using the 

items’ location within the space.  These criteria apply in the same manner as Alias values.  Once applied to the items within the 

drawing, the values persist through a take-off and allow for sorting, subtotaling, selecting, and Option Clipboard use based on the 

criteria value. 

 The addition of these criteria for use in Cap Designer would not replace the use of Alias, but would complement it.   

 In all locations within 2020 Cap where the creation, viewing, editing, removing, or reusing of an “Alias” value exists, the new 

values of “Building”, “Floor”, “Department”, and “Person” are present as well.  Here is a list of places where the new values will 

be available: 

o Assign Dialog 

o Area Tagging Dialog 

o Displayed Attributes Dialog 

o New CAP Standard Dialog 

o Edit CAP Standard Dialog 

o New CAP Part Dialog 

o Edit CAP Part Dialog 

o Block Replace Dialog: Copy Assign Tag Values checkbox 

o Compare Drawing with Worksheet Dialog 

o CAP Info Dialog 

o Block Info Edit Dialog 

o NPIL (non-plan item list): new field/values created in associated worksheet: validate these values make it into the 

CAP NPIL. 

  



 

2020 Commercial Release Notes Page 21 of 26 2020 Technologies, Inc. 

 

Commercial Software 2016.3 Corrections/Changes/Additions 

ID Issue Corrected 

General 

190887 What’s New file does not open properly at application startup, but opens correctly off of the Help menu. 

2020 Worksheet 

186882 Consolidate allows “Part Number” to be unchecked as criteria. 

181399 Worksheet displays an error when saving if a network connection was lost while the file was open lost, even if it is restored 

prior to the save. 

180752 
Feature added – The Grand Total section of a Report now better matches what can be seen within Worksheet’s Grand Total 

row. 

180524 
Feature added – Changed how the “Report view” within Report Designer works to make it easier and faster to see what a 

report template will appear displaying actual worksheet information. 

96276 
Feature added – Reconciled field names to match between Worksheet and Report Designer, added fields previously 

unavailable in Report Designer and added the ability to use the logo image as set in Worksheet preferences. 

2020 Giza 

40319 Giza Hatch function not working as expected. 

2020 Cap 

48795 Creating and placing a Cap Standard increases the size of a drawing disproportionately.   

2020 Visual Impression 

190515 Visual Impression is not respecting 3D heights set in a design tool if the values are not whole numbers. 

192314 
A Windows Security update caused a problem where Visual Impression is unable to run.  (This was previously delivered as a 

“hotfix” as well.) 

115301 
Repeated back & forth between Cap within AutoCAD x64 (visualizing within 2020 Visual Impression and applying back to 

Cap repeatedly) can cause instability within Cap/AutoCAD, sometimes resulting in AutoCAD erroring out. 
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Known Issues 
Please be aware of the issues noted below.  Most of these issues affect a small number of users because of the specific or unique 

circumstances under which they occur.  However, 2020 feels it is important to fully disclose these known scenarios and workarounds.  

As always, 2020 strongly recommends you fully check your work yourself prior to submitting orders.  2020 and the manufacturers it 

supports cannot be held responsible for incorrect specifications or drawings.  Please refer to your Software End User License Agreement 

for more details. 

1.5 General 
Issue: When installing the 2015 version of Commercial Software from the software DVD on a Windows 10 system, the install will present 

messages stating that one or more prerequisite packages fail to install.  A message stating "This application is incompatible with your 

operating system" may also be seen for one or more parts of the software installation.     

Workaround: These errors can be disregarded and closed. Installing the 2015.1 SP will correct any problems relating to the 

software installation when it is installed immediately after the DVD-based 2015.0 version. 

Issue: After installing the latest version of Commercial Software, the shortcuts are not updated to the new icons due to the way that 

Windows caches icon images.  

Workaround: The icons eventually switch over to the new version(s) on their own.  Alternately, new shortcuts can be manually 

created. 

Issue: When installing catalogs to a non-default location on a 64-bit system (“normal” install, not a Network/Client install) the required 

files for automation may not be located by the software, resulting in Automation Palettes that do not contain all of the proper user 

interface elements. 

Workaround: Please contact 20-20 Customer Support for in resolving this issue. 

Issue: There are known issues with UNC pathing and CAP Studio. 

Workaround: 20-20 Technologies recommends using mapped drive letters when dealing with folder locations.  NOTE: This can 

happen even when "My Documents" folder is pointed to a network location instead of your local hard drive. Check with your IT 

administrator to find out if this is your issue. 

Issue: Content cannot be added through Preferences in CAP Studio when installed on Windows 7 or Windows Vista. 

Workaround: Use the Catalog Maintenance feature of the monthly content disk set. 

1.6 2020 Worksheet 
Issue: When a Worksheet is repeatedly saved, it grows in size.  This can lead to large files. 

Workaround: Periodically use the “Purge” command within 20-20 Worksheet.  This command is located in the “File” menu. 

Issue: When 20-20 Worksheet is set to run in “Windows XP Compatibility Mode” its performance will degrade over time.  (This is set by 

right-clicking on the desktop shortcut and selecting the proper item from the pop-up menu.) 

Workaround(s): Do not run Worksheet in “Windows XP Compatibility Mode”. 

Issue: DPP discounts on non-DPP items do not persist through an "Update Worksheet" command 

Workaround: Only use DPP discounts on DPP-supported catalogs. 
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1.7 2020 Cap 
Issue: You install or update Cap/AutoCAD and the Cap Designer menu and/or toolbars do not appear in AutoCAD.  Typing “CAP” at the 

command line does nothing or produces the error “unknown command”. 

Workaround: Manually load the correct .ARX file from the CAP Studio installation folder.  

Issue: Dependency-related graphics (Canadian and GSA versions of American catalogs and/or manufacturers) do not work with Block 

Replace. 

Workaround: Manually find and replace items.  Using “Highlight by Part Number” or “Highlight by Select” can aid in this 

process. 

Issue: Creating Associated Worksheets for large drawings or updating large drawings with Associated Worksheet information can use 

excessively high amounts of memory (by AutoCAD) which may lead to AutoCAD unexpectedly closing.  

Workaround: None at this time. In cases where Associated Takeoff cannot be completed, workaround is to use standard visual 

worksheet takeoff; the drawing can then later be manually updated against that worksheet. 

Issue: Cap Bounds that overlap may not appear properly in a Worksheet Take-off.  

Workaround: Be sure that Cap Bounds are not overlapping or touching. 

1.8 2020 Cap - Design Automation 
Issue: If an XSITE drawing is opened when Cap is NOT running, problems can occur.  These problems may be related to saving, the 

removal of items from the drawing, and moving items. In some cases, the problem will be immediately seen while in other cases, the 

problem will not be seen immediately. 

Workaround: Make sure Cap is loaded (from the command line in AutoCAD) before opening any drawings with XSITE 

components already in them. 

Issue: Error messages occur when using XSITE in any of the following manners inside of AutoCAD: a) within a Cap Standard; b) as a 

WBLOCK from another drawing; c) using COPYCLIP from one drawing to another; d) inserting one drawing into another. 

Workaround: At this time, there is no workaround to prevent the error messages.  In some scenarios, the error messages occur 

even though there truly is not a problem with the drawing. To use elevations created in one drawing in another drawing, use 

the “SaveAs” function to create the second drawing. If you use XSITE graphics often, have encountered error messages and are 

concerned about your drawing(s), please contact technical support at (800) 638-6002 and we would be happy to discuss the 

problem. 

Issue: When selecting from the dropdown list in the Kimball XSITE Tag Manager, the use of existing tags does not work when those tags 

have skipped options. 

Workaround: Go through the normal process of re-optioning the item rather than selecting a Finish Code. 

Issue: Dependency-related graphics (Canadian and GSA versions of American catalogs and/or manufacturers) do not work with CAPTile 

or AutoConnectors.  Scenario: You have placed graphics into your drawing from a Dependency-related catalog, and realize that neither 

CAPTile nor AutoConnectors work on them. 

Workaround: Use US graphics, and once a Worksheet take-off has been done, change the catalog of manufacturer codes to the 

corresponding Canadian or GSA codes. 
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Issue: CAP Designer’s Automation functions (AutoHardware, XSite, Panel Builder, etc.) might not work correctly if your regional settings 

in Windows are not set to English. 

Workaround: Set Window’s regional settings to English if you experience a problem and it is necessary to run the specific 

Automation functions that exhibit the problem.  

1.9 2020 Giza 
Issue: Giza catalog data is designed to work with newer versions of Giza Studio.  If an older version is used a message will appear to that 

effect. 

Workaround: Update to a newer (preferably newest) version of Giza Studio. 

Issue: When Giza is run on Windows 7 or Windows Vista operating systems Frame Designs cannot be imported  

into a CDB file from another CDB file (Giza Project). 

Workaround:  With the Frame Designer interface, Export the specific Frame Design from the source CDB and then import that 

exported Frame Design into the current CDB, choosing to import “Design Sets” rather than “Giza Projects”; the exported Frame 

Design will then appear and be able to be imported into the CDB. 

1.10 2020 Visual Impression 
Issue: An “Out of Memory” situation may occur when working with very large scenes in Visual Impression.   

Workaround:  Reduce the size and/or complexity of visualized scenes 

Issue: Some items’ 3D images appear to be lower quality when compared to the images as seen in the single item preview used by 20-

20 Options. 

Workaround(s): There is no current workaround to this issue.  Quality is directly related to how the 3D shape itself is drawn. 

Please report occurrences of this problem to commercial.support@2020.net  including the mfg. code, cat code, and part number.  

Issue: Dependent upon the resources of the computer, Visual Impression may have display issues.  Older or underpowered video cards 

and/or out-of-date video card drivers cause this scenario.     

Workaround(s):  Within Visual Impression, go to Settings and uncheck the “Use hardware for UI elements (recommended)” –

and/or-- update your video drivers to a more current version.  

Issue: When taking “Snapshots” of a scene within Visual Impression, on a Windows XP system, “boxes” may appear in the snapshots.  

These “boxes” will be located where the screen elements for materials, item list, etc. were on the screen when the snapshot was taken.   

Workaround:  In many cases, updating to the latest video drivers has corrected the problem; in other cases, it has not.  Cases 

not corrected by updating video drivers have no workaround at this time. 

Issue: When viewing a scene in “Side 2D”, a grid pattern will appear if and a room item is selected.  

Workaround:  Deselect any selected room items and view the scene in “Side 2D”. 

Issue: When an "Apply" is done to a visualized worksheet, it grows in size.  This can lead to large files. 

Workaround: Periodically use the “Purge” command within 20-20 Worksheet.  This command is located in the “File” menu. 
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Customer Support 
20-20 Technologies Inc. Customer Services personnel are committed to providing the best possible technical support to all 2020 

Commercial customers.  For technical support, consult the 20-20 Technologies Inc. Support Web site at:    

http://www.2020spaces.com/contact-us/ 

Follow this link to be part of the 2020 Community!   

http://www.2020spaces.com/forums/forum/cube/  

Trademarks 
2020 Worksheet, 2020 Cap, 2020 Giza, 2020 Visual Impression, and 2020 Visual Materials are registered trademarks of 2020 

Technologies Inc. 

Microsoft and Windows are trademarks or registered trademarks of Microsoft Corporation in the United States and/or other countries. 

Other trademarks mentioned in this document are registered property of their respective owners. 
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